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1 INTRODUCTION

Welcome to this User Guide for Kronos 5.0 on After Effects.
We hope you enjoy using the Kronos and MotionBlur plug-ins.
Note Kronos 5.0 on After Effects contains both the Kronos and MotionBlur plug-

ins in a single package. Kronos can be used to add motion blur, but for ease
of use, MotionBlur is also supplied as a stand alone plug-in.

About this User This User Guide tells you how to install and use Kronos 5.0 on After Effects.
Guide This guide assumes you are familiar with After Effects and the machine it is
running on.

For the most up to date information, please see the Kronos product pages
and the latest user guide on our web site at http://www.thefoundry.co.uk.

Release Notes For information on system requirements, new features, improvements, fixed
bugs, known bugs and workarounds, see "Appendix A: Release Notes” on
page 43.

Example |mages Example images for use with the Kronos plug-in can be downloaded from

our web site http://www.thefoundry.co.uk.

|nsta||ing Kronos Please note that installing Kronos 5.0 will effectively overwrite any other
versions of Kronos that have been installed to the default location.

On Windows Kronos 5.0 is distributed as a software download from our web site at
http://www.thefoundry.co.uk. To install Kronos on a computer running
Windows, follow these instructions:

1. Download the correct installation file from our web site at
www.thefoundry.co.uk.

2. Unzip the file and double-click on the EXE file to launch the installer.
Follow the on-screen instructions to install Kronos.

VISUAL EFFECTS SOFTWARE
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On Mac

Licensing Kronos

Note

Kronos 5.0 is distributed as a software download from our web site at
http://www.thefoundry.co.uk. To install Kronos on a Mac, follow these

instructions:

1.

Download the correct installation file from our web site at
www.thefoundry.co.uk.

Double-click on the downloaded DMG file.
Double-click on the PKG file that is created.
Follow the on-screen instructions to install Kronos.

You can licence, or activate, Kronos in one of two ways:

1.

Licence Key—a sequence of numbers and letters stored in a plain text
file that unlocks Kronos.

Using FLEXIm encryption, licence keys can be created for a particular
computer enabling the software to run only on that computer. These are
called node locked licences. We also supply floating licences that will
unlock Kronos on any computer networked to a Foundry Licensing Tools
(FLT) server.

Here is an example node-locked (uncounted) licence that expires on 31
July 2010 for a computer running Kronos with a System ID of
00123fdb9e9f. Node-locked licences allow you to run Kronos on one
machine only.

INCREMENT kronos_ae_i foundry 1.0 31-jul-2010 uncounted \
HOSTID=00123fdb9e9f ISSUED=30-jun-2010 TS_OK SIGN="030A 5EB4 \

FC1l1l 3D9C B47F 3C03 6AEE 88A5 3338 ADBY9 6E00 BES5 FC97 6021 \
7AAF 82CD D2F3 3833 E5D8 4CED A3CD"

INCREMENT kronos_ae_r foundry 1.0 31-jul-2010 uncounted \
HOSTID=00123fdb9e9f ISSUED=30-jun-2010 TS_OK SIGN="00C2 EE6A \
9BBF EEOC FA43 45EB 282C 10B7 47FA 4FE3 8C01 FF47 7A39 F35E \
8E65 8D65 7C52 3B07 E1A3 F39F 70D5"

FLT tools and a user guide to install licence keys, manage floating
licences, and diagnose licence problems can be downloaded from our web
site, http://www.thefoundry.co.uk/licensing.

Activation Key—a series of numbers and letters emailed to you that
activates Kronos.

Here is an example activation key:
krae-0101-3733-eeda-8376-df83-7235

To authenticate Kronos from the After Effects user interface:

Click the Activation button. See "Basic Controls” on page 15.
You are automatically directed to The Foundry web site log in page.

If you're logged in already, skip ahead to step 3.

The Foundry
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Other Foundry
Products

Note

2. Log in as normal, or sign up if you do not have a log in ID and password.
The Product Activation page displays.

3. Enter the activation key that was emailed to you in the first field
provided.

4. Enter your System ID in the second field.

It is very important to check the System ID matches your machine before
continuing, as Kronos will only be licensed to the computer identified
with this unique number.

You can display your System ID by clicking on the About button of The
Foundry plug-ins running on After Effects.

5. (Click Create Licence Key.
You will receive an email containing the on-screen information.
6. Follow the on-screen instruction to install the Licence Key.

The Foundry is a leading developer of visual effects and image processing
technologies for film and video post production. Its stand-alone products
include Nuke, Hiero, Mari, Katana, and Storm. The Foundry also supplies a
suite of plug-ins, including Ocula, Furnace and FurnaceCore, Keylight,
RollingShutter, Kronos, and CameraTracker for a variety of compositing
platforms, including Adobe® After Effects®, Autodesk® Flame®), Avid®)
DS™, and Apple’s Final Cut Pro®. For the full list of products and supported
platforms, visit our website at http://www.thefoundry.co.uk.

Nuke is an Academy Award(® winning compositor. It has been used to
create extraordinary images on scores of feature films, including Avatar,
District 9, The Dark Knight, Iron Man, Quantum of Solace, The Curious Case
of Benjamin Button, Transformers, and Pirates of the Caribbean: At World’s
End.

Hiero is a collaborative, scriptable timeline tool that conforms edit decision
lists and parcels out VFX shots to artists, allowing progress to be viewed in
context, and liberating your finishing systems and artists for more creative
tasks.

Mari is a creative texture-painting tool that can handle extremely complex
or texture-heavy projects. It was developed at Weta Digital and has been
used on films, such as District 9, The Day the Earth Stood Still, The Lovely
Bones, and Avatar.

Katana is a look development and lighting tool, replacing the conventional
CG pipeline with a flexible recipe-based asset workflow. Its node-based
approach allows rapid turnaround of high-complexity shots, while keeping

The Foundry
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artists in control and reducing in-house development overheads. Extensive
APIs mean it integrates with a variety of renderers and your pre-existing
shader libraries and workflow tools.

Ocula is a collection of tools that solve common problems with stereoscopic
imagery, improve productivity in post production, and ultimately help to
deliver a more rewarding 3D-stereo viewing experience.

Furnace and FurnaceCore are collections of film tools. Many of the
algorithms utilise motion estimation technology to speed up common
compositing tasks. Plug-ins include wire removal, rig removal, steadiness,
deflicker, degrain and regrain, retiming, and texture tools.

Keylight is an industry-proven blue/green screen keyer, giving results that
look photographed, not composited. The Keylight algorithm was developed
by the Computer Film Company who were honoured with a technical
achievement award for digital compositing from the Academy of Motion
Picture Arts and Sciences.

RollingShutter is a plug-in that tackles image-distortion problems often
experienced by users of CMOS cameras. The plug-in will often vastly
improve the look of distorted footage, by either minimising or eradicating
image distortions. Unlike solutions tied to camera stabilisation, that stretch
the image as a whole, the RollingShutter plug-in compensates for local
skewing and distortion in the scene, by correcting each object individually.

Kronos is a plug-in that retimes footage using motion vectors to generate
additional images between frames. Utilising NVIDIA's CUDA technology,
Kronos optimises your workflow by using both the CPU and GPU.

CameraTracker is an After Effects plug-in allowing you to pull 3D motion
tracks and matchmoves without having to leave After Effects. It analyses
the source sequence and extracts the original camera’s lens and motion
parameters, allowing you to composite 2D or 3D elements correctly with
reference to the camera used to film the shot.

Storm is a product developed in-house at The Foundry to assist RED Digital
Cinema camera production workflows from on-set to delivery. It acts as a
hub, providing access to both metadata and original RAW image files
throughout the production process.

Visit The Foundry’s web site at http://www.thefoundry.co.uk for further
details.

The Foundry
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2 GETTING STARTED

Overview Kronos is designed to slow down, speed up, and add blur based on motion
within After Effects. It works by calculating the motion in the sequence in
order to generate motion vectors. These motion vectors describe how each
pixel, or block of pixels, moves from frame to frame. Using accurate motion
vectors, the software is able to generate additional images between frames
at any point along the line of motion.

Note Kronos 5.0 on After Effects contains both the Kronos and MotionBlur plug-
ins in a single package. Kronos can be used to add motion blur, but for ease
of use, MotionBlur is also supplied as a stand alone plug-in.

Figure 2.1: Simple mix of two Figure 2.2: Kronos vector
frames to create an in interpolation of the same
between frame. two frames.

By default, Kronos is set to perform a half speed slow down. This is
achieved by generating a new frame at position 0.25 and 0.75 between the
original frames at 0 and 1. Frames are created at a quarter and three
quarters instead of zero (an original frame) and a half so as not to include
any original frames in the re-timed sequence. This avoids the pulsing that
would otherwise be seen on every other frame on a half speed slowdown.

When Kronos is used to retime, motion blur can be added to the footage
during playback. Additionally, the separate MotionBlur plug-in can be used
to manage blurring, or add blur to motion in real time independent of
Kronos.

Kronos also contains a number of controls allowing you to trade off render
time versus accuracy of vectors.

VISUAL EFFECTS SOFTWARE
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Launching Kronos

or MotionBlur

Kronos and MotionBlur on After Effects act like any other effects available
on the user interface, and as such, you can access the controls from the
Effect drop down menu or Effects & Presets panel.

To access Kronos or MotionBlur from the Effect menu, select Effect > The
Foundry > Kronos or MotionBlur.

In order to access Kronos or MotionBlur from the Effect menu, a layer must
be selected in the Viewer or Timeline.

Effect Controls

L]
B Kromos (5.00 TOXE

3D Channel 3
Audia >
Blur & Sharpen >
Channel >
Color Correction >
Distort 3
Expression Contrals 3
g Generate 3
Keying 3
Matte 3
Noise & Grain 3
Obsolete 3
Perspective >
Simulation >
Stylize *

»

>

3

>

The Faundry
Time
Transition
Utility

To access Kronos or MotionBlur from the Effects & Presets panel, select
The Foundry and double-click Kronos or MotionBlur.

Effects & Presets

» Expression Controls
» Generate

» Keying

» Matte

» Noise & Grain
» Obsolete

» Perspective

» Simulation

> Stylize

> Text

v The Foundry

Ef MotionBlur (5:0)

» Time

When you apply Kronos or MotionBlur for the first time, you may experience
some delay before you can access the plug-in settings. This delay is due to

The Foundry
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Optimising Kronos

Note

the graphics processing unit (GPU) compiling some additional parallel thread
execution (PTX) information to allow the plug-in optimisation to run.

Figure 2.3: Initial plug-in startup.

Once the progress bar shown in Figure 2.3 disappears, the plug-in is ready
for use.

Kronos features processing device selection as standard, optimising your
work flow by assigning processor draining tasks to the graphics processing
unit (GPU).

Kronos is set to use the GPU by default unless the GPU is underpowered or
malfunctioning, at which point processing switches back to the CPU.

Some high resolution layers may also cause Kronos to switch to the CPU
when the GPU runs out of texture memory.

To manually switch between processing devices, select the required device
from the Device drop down menu.

uning
n Blur
verlay Vectors

Show

Matte Source

Warp

Intel Core2 Duo E7600 @ 3.06GHz

© GeForce 9400

The Foundry
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You can view the processing rate in frames per second (fps) in the Info
panel in the top right of the default After Effects interface. Figure 2.4
shows the improvement in processing performance between the CPU on the

left and GPU on the right.

Note T7he result you can achieve from swapping device is dependent on the GPU
installed in your system—some laptop or older mode!/ GPUs may compute

more slowly than the CPU.

Preview

I« <1 » 1> Pl © = 1>

RAM Preview Options v
Frame Rate Skip Resolution
Auto v

From Current Time Full Screen

Preview
I« <« > > >l 4 0>

RAM Preview Options v

Frame Rate Skip Resolution

| '~ [ Auto v

From Current Time Full Screen

Figure 2.4: CPU and GPU processing times in fps.

The Foundry
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Quick Start
Retiming

Note

For those of you who are familiar with After Effects, you may notice there
are many similarities between the Kronos plug-in and Timewarp effects. As
a general rule of thumb, if your retiming worked using Timewarp, there is a
good chance that Kronos will reproduce the same result.

On the Kronos panel you can see that the default settings retime the
currently selected layer to half speed.

M &y ' Effect Controls: Tutoriall_[01-15].jpg ~
Tutoriall « Tutoriall_[01-15].jpg

LAE] Kronos (5.0) |

¥ About

(©)KkRONOS

Original Colour Space sRGB -

Timing eed v
» D Speed % 50.0
»

» Tuning

» Motion Blur
Overlay Vectors

» © Vector Spacing 2
Show Result
Matte Source None

Warp Layer None
Device GeForce 9400

Figure 2.5: The default Kronos panel.

One of the most basic functions of Kronos is to retime layers. You can
accomplish this by simply altering the Speed value.

Increasing the Speed% value increases playback speed and vice-versa. For
example, a value of 50% is half speed, 100% is real time, and 200% is
double time.

To get the best results from Kronos, you should use the Speed setting in
conjunction with the other controls and methods outlined elsewhere in this
User Guide.

There are three ways to set the Speed value:

¢ Move the Speed slider left and right to alter the retime value.

* Hover the mouse pointer over the Speed value and click and drag left and
right to alter the retime value.

e Click the Speed value and enter the required retime value directly in to
the field using the keyboard.

For more detailed information on Kronos retiming, see “Using Kronos” on
page 15.

The Foundry
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GETTING STARTED
Quick Start MotionBlur

Quick Start Once again, for those of you who are familiar with After Effects, you may
MotionBlur notice the similarities between the MotionBlur plug-in and Timewarp’s
Motion Blur effects.

Motion Blur drop down options on the Kronos panel are used to add blur
effects to layers within After Effects.

Note T7he settings within the MotionBlur stand alone plug-in are identical to
those found in Kronos’ Motion Blur parameter group.

1. Click the reveal arrow to display the default Motion Blur settings.
2. Check Enable Motion Blur to enable the greyed out options.

M &y ' Effect Controls: Tutoriall_[01-15].jpg ~
Tutoriall « Tutoriall_[01-15).jpg

L] Kronos (5.0) |
(©)krONOS

v About
Original Colour Space sRGB A

Timing Speed v
» 0 Speed % 100.(

» Tuning
. Motion Blur

'3 Enable Motion Blur O
»
»

Overlay Vectors

» ) Vector Spacing 2
Show Result
Matte Source None

Warp Layer None
Device GeForce 9400

3. The default Shutter Samples, Shutter Angle, and Shutter Sync% values
produce the following blur effect in real time (Speed% value 100).

Figure 2.6: Original footage. Figure 2.7: Footage after a default
blur is applied.

For more information on MotionBlur, see "Using MotionBlur” on page 29.

The Foundry Kronos 5.0 on After Effects
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3 UsING KRONOS

Getting the best results from Kronos involves more than simply applying a
retime value to a layer and sitting back to enjoy the results. The following
chapter aims to instruct you on using the tools included in the Kronos
package to really improve your final output.

Basic Controls Kronos’ basic controls show effect information, provide an activation
function for licensing purposes, and allow you to reset or turn effects on or
off without removing them from layers.

M &y ' Effect Controls: Tutoriall_[01-15].jpg

Tutoriall » Tutoriall_[01-15].jpg

Ll 2] Kronos (5.0)

¥ About

Original Colour Space
Timing
» ) Speed %

Menu Bar The menu bar at the top of the Kronos panel displays the current effect and
file names as well as the following buttons.

- Reveal Show or hide the current effect panel.
- Effect Toggle |Enable or disable the current effect to quickly view the
fi results.
Reset Return all Kronos settings to their default values.
Activation Click to open a web page for activation of Kronos serial num-

bers. See “Licensing Kronos” on page 6.

About... Displays the About window containing information on Kronos.

VISUAL EFFECTS SOFTWARE
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Selecting the
Correct Colour
Space

Colour Space describes the colour system that was used when your footage
was captured. Setting the colour space correctly is the first thing that you
should do before applying Kronos effects to a layer.

In most cases, motion vector calculation on imported footage will work well
with the default sRGB setting within Kronos. If, however, you find that your
results are not as expected, you could try the other settings to improve
your output.

M &y ' Effect Controls: Tutoriall_[01-15].jpg ~
Tutoriall « Tutoriall_[01-15].jpg
LES Kronos (5.0)

¥ About

(©)KkRONOS

Original Colour Space sRGB v
iiming Cineon

> © Speed % © sRGB |

» Tuning

» Motion Blur
Overlay Vectors

» © Vector Spacing 2
Show Result
Matte Source None

Warp Layer None
Device GeForce 9400

The following Original Colour Settings are supported:

e (Cineon—a common colour space typically used for film images, for
example .dpx file types.

¢ sRGB—the default setting, typically used by video cameras.

* Linear—this option effectively disables the colour space information
associated with the footage to try and improve motion vector
calculation.

One of the most fundamental functions of Kronos is retiming layers. The
Timing drop down menu enables you to select the required retiming mode:

» Speed—causes Kronos to retime the layer using the Speed% value.
* Frame—causes Kronos to retime the layer using the Frame value.

The Speed and Frame settings are described below.

The Foundry
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Timing

Speed Retiming

Frame Retiming

Note

Altering the Speed% value causes the layer to playback at the retimed speed
specified.

Increasing the Speed% value increases playback speed and vice-versa. For
example, a value of 50% is equal to half speed, 100% to real time, and
200% to double time.

To retime a layer using the Speed% value:

1. Select Timing > Speed.

2. Move the Speed% slider left and right to alter the retime value,
OR

Hover the mouse pointer over the Speed% value and click and drag left
and right to alter the retime value,

OR

Click the Speed% value and enter the required retime value directly in to
the field using the keyboard.

3. Press Play to process and view the results.

The figures below represent frame 20 in a sequence with the Speed% value
set at 50%, 100%, and 200% respectively. You can use the position of the
oar to illustrate the retime effect speeding up the clip from left to right.

If you are new to Kronos and After Effects, you may find the Tutorials
chapter useful for basic retiming methods. See "Tutorial 1: Speed Retiming”
on page 34.

You can also retime a layer in terms of Frames. Instead of changing the
layer’s playback speed in terms of overall duration, you can describe the
retiming by identifying which source frame is to play at which time. For
example, to slow down a 50 frame clip by half, you can set the Frame value
to 1 at frame 1, and to 50 at frame 100.

You must set at least two keyframes to retime a layer using Frame retiming.

The Foundry
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USING KRONOS
A Note on Retiming in After Effects

To retime a layer using the Frame value:
1. Select Timing > Frame.
2. Select the frame in the timeline where you want the retime to begin.

3. Set the Frame value to the frame you want to appear at that output
position by moving the Frame slider left and right to alter the retime
value,

OR

Hover the mouse pointer over the Frame value and click and drag left
and right to alter the retime value,

OR

Click the Frame value and entering the required retime value directly in
to the field using the keyboard.

4. Select the frame in the timeline where you want the retime to finish and
repeat step 3 to enter the Frame value.

5. Press Play to process and view the results.

If you are new to Kronos and After Effects, you may find the Tutorials
chapter useful for basic retiming methods. See “Tutorial 2: Frame Ramp
Retiming” on page 37.

A Note on Retiming When slowing down a layer, for example by 50%, Kronos generates

in After Effects additional images between frames, causing the length of the clip to
increase. Within After Effects, this means that half of your layer is displaced
by the new Kronos frames, so in effect, you lose half of your footage.

Normally, you cannot extend layers past the last frame of footage, but to
compensate for this:

1. Navigate to Composition > Composition Settings and increase the
length of your composition to accommodate the extra footage. For
example, if you're using 50% speed, consider increasing the composition
length by 100%.

The Foundry Kronos 5.0 on After Effects



USING KRONOS
Tuning

Tip

Tuning

Width

Height

Pixel Aspect Ratio: ' Square

v frames per second

80, 1.2 M8 per Bbpc frame

2. Click OK.

3. Zoom out on the Timeline to show the entire composition, then navigate
to Layer > Time > Enable Time Remapping.

After Effects places two keyframes on your layer, one at the first frame and
one at the last frame. We recommend that you don’t adjust these keyframes
as they may have an adverse affect on the Kronos retiming.

4. Use the layer handle to drag the layer to the new length of the
composition.

|
Auto Keyframes

Play through the footage to confirm no frames are missing from the end
of your footage; you can always increase the composition size further.

As the name suggests, the Tuning drop down menu is used to alter the fine
detail within a layer. Often, you may have to make a series of value
judgements before applying Tuning to a retime. As a general rule of thumb,
Tuning can be seen as a trade off between accuracy and speed of
processing.

The Foundry
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USING KRONOS
Tuning

Vector Detail

Tip

Vector Detail% is used to alter the density of a layer’s vector field, and can
be adjusted using the same three methods as the Speed and Frame values. A
value of 100% will generate a vector at each pixel whereas a value of 50%
will generate a vector at every other pixel.

Bear in mind that higher Vector Detaifb values require longer to process,
but can enhance your results in some cases. Try to evaluate your needs on a
project by project basis so that you can strike a balance between quality
and processing time.

The Foundry
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USING KRONOS
Tuning

For some sequences, a high Vector Detail% value generates too much
unwanted local motion detail (Figure 3.1). Kronos’ default Vector Detail
value is 20% because often, a lower value is more appropriate (Figure 3.2).

Figure 3.2: Lower Vector Detail is more appropriate in this case.

Smoothness Vector fields usually have two important qualities: they should accurately
match similar pixels in one image to another and they should be smooth
rather than noisy. Often, it is necessary to trade one of these qualities off
against the other.

A low Smoothness% concentrates on matching detail, even if the resulting
field is jagged (Figure 3.3). A high Smoothness% misses a lot of local detail,
but is less likely to provide you with the odd spurious vector (Figure 3.4).
The default value of 50% should work well for most sequences.

The Foundry Kronos 5.0 on After Effects
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Figure 3.4: Minimal jagging as a result of a high Smoothness% value.

Flicker Compensation Flicker Compensation is designed to take into account variations in
luminance and overall flickering, which can cause problems with your
output.

Examples of variable luminance include highlights on metal surfaces, like
vehicle bodies, or bodies of water within a layer that reflect light in
unpredictable ways.

Toggle the Flicker Compensation checkbox to allow Kronos to take account
of overall brightness changes between frames.

Note As with other tuning and effects, using Flicker Compensation increases
rendering time.

The Foundry Kronos 5.0 on After Effects
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Weights

Note

Overlay Vectors

Note

In order to reduce processing time, Kronos performs most luminance
calculations using monochrome, largely ignoring colour channels. In most
cases this is perfectly acceptable, but Weights allow you to concentrate on
a particular feature in a layer by adding bias to individual colours.

Adding Weight to a particular colour may adversely affect the rest of the
layer.

Kronos provides three separate Weight controls that can be used
individually or collectively to achieve the required result.

Weight Red% 0-100% 30%
Weight Green% 0-100% 60%
Weight Blue% 0-100% 10%

For example, you can increase the blue bias Weight Blue% to allow the
algorithm to concentrate on getting the motion of a primarily blue object
correct.

Motion vectors can help you identify interactions between the background
and the direction of movement for particular pixels or blocks of pixels
within a layer. The Overlay Vectors checkbox allows you to quickly toggle
vectors on or off without re-processing your layer.

Motion Vectors displayed in the Viewer are added to your output if you
don't turn off the overlay before rendering.

The Kronos default vector space is 20, which produces the following vector
overlay.

The Foundry
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Overlay Vectors

Vector Spacing Adjusting the space between vectors displayed on a layer allows you to
customise the way in which the vector data appears.

Layers with a great deal of motion may call for a lower Vector Spacing value
to really highlight the many motion directions, whereas a high Vector
Spacing value applied to the same layer may not supply a great deal of
useful information.

Figure 3.5 and Figure 3.6 represent extremes of vector spacing. You may
find that the default value or a value somewhere in between (Figure 3.7),
provides the most useful data.

w
:

iy s i ;
Figure 3.5: A Vector Spacing Figure 3.6: A Vector Spacing
value of 4. value of 100.

SR -
s

e e

Figure 3.7: A Vector Spacing value of 40.
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Changing Viewer The Show drop down menu allows you to change what is output to the
Output viewer from Kronos or MotionBlur. The different options are designed to
help you refine your mattes by examining the result, foreground, and
background motion vector calculations:
e Result—the default setting, shows the layer with any effects added,
including the blend of foreground and background motion vectors if a
matte has been applied (Figure 3.8).
e Matte—displays the position of the matte at the selected frame on the
layer (Figure 3.9).

Note /fboth the layer and matte are set to visible in a composition with a retime
in effect, you may see two matte images if Show > Matte is selected—the
original matte and the retimed matte.

e Foreground—displays the layer calculated using only the foreground
motion vectors (Figure 3.10).

e Background—displays the layer calculated using only the background
motion vectors (Figure 3.11).

Figure 3.9: Matte.

Figure 3.10: Foreground. Figure 3.11: Background.
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Using Mattes to
Improve Results

Matte Pitfalls

Applying Mattes

Motion estimation algorithms can have difficulty making the distinction
between foreground and background in a layer, resulting in pixel drag
between overlapping objects. Masks or Mattes can assist the algorithm to
recognise these differences, reducing drag and improving the appearance of
the layer.

There are a couple of things to be aware of before you get started with

mattes that will hopefully stop you becoming frustrated.

1. The first thing to understand is that After Effects has a number of Chan-
nel and Colour Management filters that you can apply to the viewer.

The RGB and RGB Straight modes display mattes in different ways. While
not disastrous, the differences between the two can be extremely con-
fusing.

Figure 3.12: A matte around the Figure 3.13: The same matte when
canoeist’s oar in RGB mode. viewed in RGB Straight.

The reason for this is that RGB Straight uses the bounding box alpha
instead of the matte alpha.

2. You MUST pre-compose your matte layer before you use it or Kronos
uses the source layer without any effects that you apply.

When you're happy with your matte, go to Layer > Pre-compose.

When applying mattes, white areas of the matte are considered to be
foreground, and black areas background. Grey areas are used to attenuate
between foreground and background. When the Matte Layer field contains
an appropriate layer, the Matte Source parameter controls how the pixel

The Foundry
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values in the matte are used to do the masking.

¢ None—no matte is applied.

e Source Alpha—use the alpha of the source layer.

e Source Inverted Alpha—use the inverted alpha of the source layer.
e Matte Luminance—use the luminance of the matte layer.

¢ Matte Inverted Luminance—use the inverted luminance of the matte
layer.

e Matte Alpha—use the alpha of the matte layer.
e Matte Inverted Alpha—use the inverted alpha of the matte layer.

To use a matte on a layer:

1. Create a suitable animated matte and add it as a layer in the project. In
this case, the matte will be used to mask the oar. See your After Effects
User Guide for more information on creating and using mattes.

2. Pre-compose the matte layer by navigating to Layer > Pre-compose.
Select Move all attributes into the new composition and click OK.

4. Select an appropriate Matte Source from the drop down menu,
depending on the matte you are using.

5. Select the matte you created from the Matte Layer drop down menu.
Note You cannot select a Matte Layer without first specifying a Matte Source.

6. Press Play to preview the results.

Figure 3.14: Background pixel drag Figure 3.15: Pixel drag removed
around the motion of the oar. using Matte.

The Foundry Kronos 5.0 on After Effects



USING KRONOS
Warping Layers

Warping Layers When Kronos or MotionBlur is added to a layer in After Effects, all motion
vector calculation and application occurs within that layer by default.

The Warp Layer function allows you to Warp the current layer with motion
vectors from another source layer, for instance if you want to add motion
blur to a layer based on the movement in another layer.

To apply a Warp Layer, ensure that the layer you want to use as the source
is added to your composition.

Note T7he source layer must be pre-composed using Layer > Pre-Compose before
you can use it as the Warp Layer.

Click on the Warp Layer drop down menu and select the source layer from
the list.

M 'hy | Effect Controls: Tutoriall_[01-15].jpg ~
Tutoriall = Tutoriall_[01-15).jpg
v fx Kronos (5.0)

v About

Original Colour Space
Timing
) Speed %

» Tuning

* Motion Blur
Overlay Vectors

» ' Vector Spacing

Show Result

Marte Source None

Warp Layer None
Device * None

1. Tutoriall_|
2. Blur_Sample [}

The effect is applied to the current layer.
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4 USING MOTIONBLUR

The following chapter aims to instruct you on using the tools that the
Kronos and MotionBlur plug-ins provide. There are no right and wrong
settings for MotionBlur—the output depends entirely on the results you are
looking to achieve.

Note T7he settings within the MotionBlur stand alone plug-in are identical to
those found in Kronos’ Motion Blur parameter group.

To begin using MotionBlur:
1. Click the reveal arrow to display the default Motion Blur settings.
2. Check Enable Motion Blur to enable the available settings.

M ' "Effect Controls: Tutoriall_[01-15]jpg '+
Tutoriall » Tutoriall_[01-15].jpg

Ll 2] Kronos (5.0)

v About

Original Colour Space
Timing
» © Speed %

» Tuning

. Motion Blur
»  Enable Motion Blur

Overlay Vectors

» @ Vector Spacing
Show
Matte Source

Warp Layer
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Shutter Samples

Shutter Angle

Note

The Shutter Samples value determines the number of images generated
between frames during the specified Shutter Angle to create motion blur. A
higher value results in smoother motion blur, but requires more processing
time.

Figure 4.1 and Figure 4.2 show graphical representations of low and high
Shutter Samples.

Figure 4.1: A Shutter Figure 4.2: A Shutter
Samples value of 2. Samples value of 20.

In real terms, with Speed at 100 and Shutter Angle at 360, the Shutter
Samples values 2, 5, and 20 are represented in Figure 4.3. Notice that the
higher value produces smoother blur around the canoeist.

Figure 4.3: Applied Shutter Samples value of 2, 5, and 20.

Modifying the Shutter Angle is the Kronos equivalent to changing the
shutter angle of the frame. Shutter Angle values 0, 180, and 360 degrees
represent the shutter as closed, half open, and completely open. In practice,
a shutter open to 360 degrees would be open constantly and all motion in
the image would be blurred.

Kronos also gives you the option of increasing the Shutter Angle past 360
degrees, which is not possible in actual movie cameras.

In real terms, with a Speed% value of 100 and Shutter Samples value of 15,
the Shutter Angle values 360 and 1080 produce motion blur similar to that
shown in Figure 4.4 and Figure 4.5. Notice that the higher value produces
greater blur around the motion in the frame.

The Foundry
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Shutter Sync

Figure 4.4: Applied Shutter Figure 4.5: Applied Shutter
Angle value of 360. Angle value of 1080.

Kronos uses Shutter Sync% to look at where each pixel moves in the
previous and the following frame. Negative Shutter Sync% values sample
frames from before the current frame on the timeline and positive values
from frames after the current frame.

Assuming that you're using the default Shutter Samples value of 5,
Figure 4.6 shows a hypothetical object and the effect that differing Shutter
Sync% values produce, where the black rectangle represents the current

frame.

SHUTTER SYNC =-100 SHUTTER SYNC=0 SHUTTER SYNC = 100
Figure 4.6: The effect of differing Shutter Sync% values.

The values represented in Figure 4.6 are shown in real terms in Figure 4.7.
Even though the same frame is shown in each image, Shutter Sync%
negative values sample frames from before the current frame and positive
values from frames after the current frame. Notice the position of the
second canoeist changes from left to right as the Shutter Sync% value
increases.

Figure 4.7: Shutter Sync values of -100%, 0%, and 100%.

The Foundry
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Shutter Sync

The Overlay Vectors setting is useful for viewing your changes, as it can
help you see any significant differences between the vectors from each

direction.

Tip

If you are new to Kronos and After Effects, you may find the Tutorials
chapter useful for basic motion blur methods. See "Tutorial 3: Adding

MotionBlur” on page 40.

The Foundry Kronos 5.0 on After Effects
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5 TUTORIALS

Introduction

Note

The Projects

Example Images

Note

Welcome to the Kronos and MotionBlur Tutorials! If you've reviewed the
other chapters in this guide—which we highly recommend—you already
know something about the software’s capabilities. These tutorials show how
to pull everything together through a series of practical examples.

These tutorials assume that you are reasonably familiar with the After
Effects interface and basic compositing theory.

e Tutorial 1: Speed Retiming—a basic run-through of retiming layers
within your projects using the Speed% value.

e Tutorial 2: Frame Ramp Retiming—increasing and decreasing layer speed
over time using keyframes.

e Tutorial 3: Adding MotionBlur—applying motion blur and managing
output quality.

Before you continue, download the tutorial files from The Foundry web site
http://www.thefoundry.co.uk and move them to a directory you'll create,

called “Kronos_Tutorials”.
You may need to unzip the files before you can use them.

It's up to you where you put the tutorial files, but bear in mind that you’ll
need them during these practical exercises.

VISUAL EFFECTS SOFTWARE
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TUTORIALS
Tutorial 1: Speed Retiming

Tutorial 1: Speed
Retiming

Preparing the
Workspace

Simple speed retiming causes the entire current layer to playback at the
retimed speed specified. Increasing the Speed% value, increases playback
speed and vice-versa. For example, a value of 50% is equal to half speed,
100% to real time, and 200% to double time.

In this tutorial, you'll import some footage, apply Kronos as an effect, and
apply a basic retime to decrease the playback speed.

First, you'll set up the workspace and apply Kronos as an effect on a layer:
1. Launch After Effects as normal and navigate to File > Import > File.

Edit. ition I8
New »
Open Project... ®o
== Open Recent Projects >

Browse n Bridge... Toxo
Browse Template Projects...

Close =W
Close Project

Save As... Rrg 13
Save a Copy...

Save a Copy As XML...
Increment and Save  C{r M5

Import Recent Footage *
Export >

oy ’ Vanishing Point (.vpe)...
Go to Adobe Story... i

Solid...

2. Navigate to the folder containing the tutorial files and open
Tutorial1_01.jpg (After Effects imports the entire contents of the folder
automatically).

3. Drag and drop the content from the Project tab to the Viewer and click
the image to select the layer.

4. Navigate to Effect > The Foundry > Kronos.

After Effects  File Edin Animation  View  Window
T = Effect Controls n
= LR  Kronos (5.0) TONE

3D Channel

Audia

Blur & Sharpen

Channel

Color Correction

Distort.

Expression Contrals
gl Generate

Keying

Matte

Noise & Grain
Obsoclete

Perspective
Simulation
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5. The Kronos panel displays in the Effects Control tab.

M &y | Effect Controls: Tutoriall_[01-15].jpg '~

Tutoriall » Tutoriall_[01-15].jpg

(©)kroNOS

v About
Original Colour Space sRGB A
Timing Speed v
» 1 Speed %

» Tuning

» Motion Blur
Overlay Vectors

» @ Vector Spacing :
Show Result
Matte Source None

Warp Layer None
Device GeForce 9400

Constant Retiming Let’s try reducing the playback speed to 3/4 normal speed for the entire
layer:

1. Click the Speed% reveal arrow to show the slider control.

2. Drag the slider to 75% and press Play in the Preview panel to preview
the retime.

G D e o Thul63s Q

Workspace: Standard

Preview

14 «l ¥

RAM Preview Options v

Resolution

0 * [ ¥ | Auto -

From Current Time Full Screen

For some projects, simply retiming and rendering the layer with the
default settings is sufficient.
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You may notice, however, that in frame 7 there is considerable distor-
tion present around the paddle.

You can try to remove this distortion using the Tuning settings. Let’s try
altering the Vector Detail% and Smoothness% values.

3. Click the Tuning > Vector Detail% and Smoothness% reveal arrows to
show the slider controls.

4. Drag the Vector Detail% slider to 80% and the Smoothness% slider to
90%.

5. Press Play in the Preview panel to preview the retime.

Move the playhead to frame 7 and you should see that the distortion is
reduced, but some blurring has crept in around the paddle blade.

You can experiment with the tuning settings to try and improve the
results, although sometimes trading off improvements in one area
against another is necessary.

Tip  The Tuning settings are very useful, but use them sparingly as too much
tuning can affect other areas of the layer, introducing localised motion that
wasn't visible in the original footage.
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Tutorial 2: Frame
Ramp Retiming

Gradual Retiming

Frame ramp retiming uses keyframes to alter playback speed up and down
over time. For this retiming method, we’ll need to change the Timing mode
and add some keyframes.

If you haven’t done so already, prepare your workspace as described in
“Preparing the Workspace” on page 34.

Let’s try reducing the playback speed over 8 frames then increasing it back
to the original speed towards frame 14:

1.

Navigate to the Timing drop down menu and select Frame.

M 'k "Effect Controls: Tutoriall_[01-15]jpg |

Tutoriall » Tutoriall_[01-15].jpg

Ll 2] Kronos (5.0)

¥ About

» Tuning

» Motion Blur
Overlay Vectors

» © Vector Spacing
Show
Matte Source

Notice that the Speed panel is grayed-out and the Frame panel is acti-
vated.

2. Right-click on the Frame panel and select Reveal in Timeline.

M 'k "Effect Controls: Tutoriall_[01-15]jpg '
Tutoriall » Tutoriall_[01-15].jpg

(©)krONOS

v About
Original Colour Space sRGB v
Timing Frame v

WL Edit Value...
* Motion

Separate Dimensions

Add Keyframe

Previous Keyframe

Reveal in Timeline
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After Effects adds the Kronos controls to the left Timeline panel. The
default Frame setting is 1.0, which sets the first frame on the Timeline
to frame 1 of the layer.

| = Bt 2O O DN

ol ® G & < -—- -
: L oy s G T ——
v Effects
+ Kronos (5.0)
4 W

™ Timing

@ Frame
* Tuning

3. Click the stopwatch icon next to Frame to set a keyframe at the first
frame on the Timeline.

4. Move the playhead to frame 8 and set the Frame value to 4.0. Kronos
sets frame 8 on the Timeline to frame 4 of the layer, effectively reducing
the playback speed by half leading up to frame 8.

Keyframes

5. Move the playhead to frame 14 and set the Frame value to 15.0. Kronos
sets frame 14 on the Timeline to the last frame of the layer, effectively
returning the playback speed to normal at frame 14.

6. Press Play in the Preview panel to preview the retime.

Once the process has completed, you should be able to see the result of
the retime. In reality, the length of the clip is a little too short to see
clearly.

7. Return to the beginning of the layer and play through each frame with
the Next Frame arrow in the Preview panel. You should notice that the
Frame value in the Timeline panel changes overtime—slowly up to frame
8 and more quickly toward the final frame.

Frame 2.5 Frame 7.7
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The retime can be represented by the graph shown in Figure 5.1.

Source Frames

m B
m B
L]
20 s B
[ ]

Figure 5.1: Graph showing a retime ramping up to real
time at frame 14.

Notice the marked speed increase after frame 8 as the retime approaches
realtime at frame 14.

Try your own frame ramp retime on some longer sequences to really see the
retime results!

The Foundry

Kronos 5.0 on After Effects

39



TUTORIALS
Tutorial 3: Adding MotionBlur

Tutorial 3: Adding
MotionBlur

Note

MotionBlur can be used to add realism to moving footage, for example the
perception of speed in Formula 1 cars, or in the case of this tutorial to add
a more dreamlike feel to the layer.

If you haven’t done so already, prepare your workspace as described in
“Preparing the Workspace” on page 34.

For the duration of this tutorial, we're going to assume that no retime effect
is required, so the first thing you need to do is set the Speed% value to

100%, or realtime.

If you launch MotionBlur independently, this step is not required.

M ‘b "Effect Controls: Tutoriall_[01-15]jpg '+
Tutoriall « Tutoriall_[01-15).jpg

Ll 2] Kronos (5.0)

¥ About

(©)krONOS

Original Colour Space sRGB -
Timing eed v

» ' Speed % 100.0)

» Tuning

Let’s try creating a dreamlike feel for the example layer:

Click the Motion Blur reveal arrow to display the available parameters
and select the Enable Motion Blur checkbox.

M &y ' Effect Controls: Tutoriall_[01-15].jpg ~
Tutoriall « Tutoriall_[01-15].jpg

S Kronos (5.0)|
()krONOS

w About
Original Colour Space sRGB A
Timing Speed v
» © Speed % ]

» Tuning

 Motion Blur
Enable Motion Blur @
» O Shutter Samples g
) Shutter Angle
2 Shutter Sync %
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2. You can see immediately that the default MotionBlur settings have
applied some blur to the layer.

Figure 5.2: Original layer at Figure 5.3: Default MotionBlur
frame 8. settings applied to the same frame.

For the purposes of this tutorial, however, we're looking for something a
little more dramatic!

3. Let's increase the Shutter Samples to 15, so that MotionBlur creates
more frames for a smoother blur.

w Motion Blur
? Enable Motion Blur
» Shutter Samples
» Shutter Angle
» Shutter Sync %

4. Increase the Shutter Angle to 1080, so that MotionBlur produces a
large amount of blur across the image.

w Motion Blur
® Enable Motion Blur
) Shutter Samples
) Shutter Angle
» Shutter Sync %

5. Reduce the Shutter Sync% to -50%, so that MotionBlur samples frames
from before the current frame to create a drag effect.

v Motion Blur
» Enable Motion Blur
Shutter Samples

) Shutter Angle

utter Sync % 50,4
™ Overlay Vectors "b
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These settings produce the exaggerated dreamlike quality shown in
Figure 5.4. In practice, you might never set the parameters so high, but
they illustrate some of the effects you can achieve using MotionBlur.

Figure 5.4: Exaggerated settings applied to frame 8.

You can also use MotionBlur in conjunction with keyframes in exactly the
same way as described in Tutorial 2.

The Foundry
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APPENDIX A: RELEASE NOTES

Release Notes This appendix describes the requirements, new features, improvements over
previous versions, fixed bugs, and known bugs and workarounds in Kronos.

Kronos 5.0v3 This is a maintenance release that adds support for After Effects CS6 and
fixes one bug.

Release Date
July 2012

Requirements
1. Either:
e After Effects CS6 on Mac OS X 10.6.8 or 10.7 64-bit, or
¢ After Effects CS6 on Windows 7 64-bit, or
e After Effects CS5 or C55.5 on Mac OS X 10.5.8 or 10.6 64-bit, or
e After Effects CS5 or C55.5 on Windows 7 64-bit.
2. Foundry Licensing Tools (FLT 7.0v1 or later) for floating licences.

Requirements for CUDA Accelerated Rendering (CPU fallback available):

1. A GPU that supports CUDA technology. The following cards have been
tested with Kronos:

e GeForce GTX 285 (Windows and Mac 0S)
e Quadro FX 3800 (Windows)

e Quadro FX 4800 (Windows and Mac 0OS)
e Quadro FX 5800 (Windows)

2. Ensure that you have the correct CUDA compatible drivers installed for
your GPU. Contact support@thefoundry.co.uk for more information.

New Features
There are no new features in this release.

Feature Enhancements
There are no enhancements to existing features in this release.

VISUAL EFFECTS SOFTWARE
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Release Notes

Kronos 5.0v2

Fixed Bugs

e BUGID 27446 - Running Kronos on CS6 rendered the first frame
repeatedly for the entire sequence.

Known Bugs and Workarounds
There are currently no known bugs or workarounds.

This is a maintenance release that adds support for After Effects CS5.5 and
fixes one bug.

Release Date
April 2011

Requirements

1. Windows 7 (64-bit) or Mac OS X 10.6.4 and above (64-bit).

2. After Effects CS5 or CS5.5 on Windows or Mac 0S X.

3. Foundry FLEXIm Tools (FFT 5.0v1 or later) for floating licences.

Requirements for CUDA Accelerated Rendering (CPU fallback available):

1. A GPU that supports CUDA technology. The following cards have been
tested with Kronos:

e GeForce GTX 285 (Windows and Mac 0S)
e Quadro FX 3800 (Windows)
e Quadro FX 4800 (Windows and Mac 0OS)
e Quadro FX 5800 (Windows)

2. Ensure that you have the correct CUDA compatible drivers installed for
your GPU. Contact support@thefoundry.co.uk for more information.

New Features
There are no new features in this release.

Feature Enhancements
There are no enhancements to existing features in this release.

Fixed Bugs
BUG ID 16354 - Kronos produced unexpected results on 12-core machines.

The Foundry
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Release Notes

Kronos 5.0v1

This is a new release for Kronos on After Effects. There are two plug-ins in
this release: Kronos and MotionBlur.

Release Date
10 August 2010

Requirements

1. Windows 7 64-bit or Mac OS X 10.6.4 64-bit.

2. After Effects CS5 on Windows or Mac OS X.

3. Foundry FLEXIm Tools (FFT 5.0v1 or later) for floating licences.

Requirements for CUDA Accelerated Rendering (CPU fallback available):

1. A GPU that supports CUDA technology. The following cards have been
tested with Kronos:

e GeForce GTX 285 (Windows and Mac 0S)
e Quadro FX 3800 (Windows)
e Quadro FX 4800 (Windows and Mac 0OS)
e Quadro FX 5800 (Windows)

2. Ensure that you have the correct CUDA compatible drivers installed for
your GPU. Contact support@thefoundry.co.uk for more information.

New Features
This section will describe new features in future releases.

Feature Enhancements
This section will describe feature enhancements in future releases.

Fixed Bugs
This section will describe fixed bugs in future releases.

Known Bugs and Workarounds
There are currently no known bugs or workarounds.
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APPENDIX B: THIRD PARTY LICENSES

Third Party Licences

This appendix lists third party libraries used in Kronos, along with their licences.

Boost Source code function / |Boost Software Licence - Version 1.0 - August 17th, 2003

template library Permission is hereby granted, free of charge, to any person or organization obtaining

a copy of the software and accompanying documentation covered by this licence (the
“Software”) to use, reproduce, display, distribute, execute, and transmit the Soft-
ware, and to prepare derivative works of the Software, and to permit third-parties to
whom the Software is furnished to do so, all subject to the following:

The copyright notices in the Software and this entire statement, including the above
licence grant, this restriction and the following disclaimer, must be included in all
copies of the Software, in whole or in part, and all derivative works of the Software,
unless such copies or derivative works are solely in the form of machine-executable
object code generated by a source language processor.

THE SOFTWARE IS PROVIDED “AS IS, WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANT-
ABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN
NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFT-
WARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFT-
WARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Expat XML parser Copyright © 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark
Cooper

Copyright © 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the “Software”), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to per-
mit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies
or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANT-
ABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO
EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR
THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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FreeType

Font support

Portions of this software are copyright © 2008 The FreeType Project

(www.freetype.org). All rights reserved.

FTGL

OpenGL support

FTGL - OpenGL font library

Copyright © 2001-2004 Henry Maddocks ftgl@opengl.geek.nz
Copyright © 2008 Sam Hocevar sam@zoy.org

Copyright © 2008 Sean Morrison learner@bricad.org

Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the “Software”), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to per-
mit persons to whom the Software is furnished to do so, subject to the following
conditions

The above copyright notice and this permission notice shall be included in all copies
or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS“, WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANT-
ABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO
EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR
THE USE OR OTHER DEALINGS IN THE SOFTWARE.

VXL

Computer vision

Copyright © 2000-2003 TargetJr Consortium GE Corporate Research and Develop-
ment (GE CRD) 1 Research Circle Niskayuna, NY 12309 All Rights Reserved Repro-
duction rights limited as described below.

Permission to use, copy, modify, distribute, and sell this software and its documenta-
tion for any purpose is hereby granted without fee, provided that (i) the above copy-
right notice and this permission notice appear in all copies of the software and
related documentation, (ji) the name TargetJr Consortium (represented by GE CRD),
may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of GE CRD, and (iii) any modifications are clearly
marked and summarized in a change history log.

THE SOFTWARE IS PROVIDED “AS IS AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WAR-
RANTY OF MER- CHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO
EVENT SHALL THE TAR- GETIR CONSORTIUM BE LIABLE FOR ANY SPECIAL, INCIDEN-
TAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR
NOT ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR ON ANY THEORY OF LIA-
BILITY ARISING OUT OF OR IN CONNEC- TION WITH THE USE OR PERFORMANCE OF
THIS SOFTWARE.
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End User License Agreement

IMPORTANT: BY INSTALLING THIS SOFTWARE YOU ACKNOWLEDGE THAT YOU HAVE READ THIS
AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. IF YOU DO
NOT AGREE TO THE TERMS OF THIS AGREEMENT DO NOT INSTALL, COPY OR USE THE SOFTWARE.

This END USER LICENSE AGREEMENT (this "Agreement”) is made by and between The Foundry Visionmongers Ltd., a
company registered in England and Wales, ("The Foundry"), and you, as either an individual or a single entity
("Licensee").

In consideration of the mutual covenants contained herein and for other good and valuable consideration (the receipt
and sufficiency of which is acknowledged by each party hereto) the parties agree as follows:

SECTION 1. GRANT OF LICENSE.

Subject to the limitations of Section 2, The Foundry hereby grants to Licensee a limited, non-transferable
and non-exclusive license to install and use a machine readable, object code version of this software
program (the "Software") and accompanying user guide and other documentation (collectively, the
"Documentation”) solely for Licensee's own internal business purposes (collectively, the "License");
provided, however, Licensee's right to install and use the Software and the Documentation is limited to
those rights expressly set out in this Agreement.

SECTION 2. RESTRICTIONS ON USE.

Licensee is authorized to use the Software in machine readable, object code form only, and Licensee shall
not: (a) assign, sublicense, sell, distribute, transfer, pledge, lease, rent, share or export the Software, the
Documentation or Licensee's rights hereunder; (b) alter or circumvent the copy protection mechanisms in
the Software or reverse engineer, decompile, disassemble or otherwise attempt to discover the source
code of the Software; (c) modify, adapt, translate or create derivative works based on the Software or
Documentation; (d) use, or allow the use of, the Software or Documentation on any project other than a
project produced by Licensee (an "Authorized Project"); (e) allow or permit anyone (other than Licensee and
Licensee's authorized employees to the extent they are working on an Authorized Project) to use or have
access to the Software or Documentation; (f) copy or install the Software or Documentation other than as
expressly provided for herein; or (g) take any action, or fail to take action, that could adversely affect the
trademarks, service marks, patents, trade secrets, copyrights or other intellectual property rights of The
Foundry or any third party with intellectual property rights in the Software (each, a "Third Party Licensor").
Furthermore, for purposes of this Section 2, the term "Software” shall include any derivatives of the
Software.

Licensee shall install and use only a single copy of the Software on one computer, unless the Software is installed in
a "floating license” environment, in which case Licensee may install the Software on more than one computer;

provided, however, Licensee shall not at any one time use more copies of the Software than the total number of valid
Software licenses purchased by Licensee.

Please note that in order to guard against unlicensed use of the Software a licence key is required to access and
enable the Software. The issuing of replacement or substituted licence keys if the Software is moved from one
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computer to another is subject to and strictly in accordance with The Foundry’s Licence Transfer Policy, which is
available on The Foundry’s website and which requires a fee to be paid in certain circumstances. The Foundry may
from time to time and at its sole discretion vary the terms and conditions of the Licence Transfer Policy.

Furthermore, if the Software can be licensed on an "interactive” or "non-interactive” basis, licensee shall be
authorized to use a non-interactive version of the Software for rendering purposes only (i.e., on a CPU, without a
user, in a non-interactive capacity) and shall not use such Software on workstations or otherwise in a user-
interactive capacity. Licensee shall be authorized to use an interactive version of the Software for both interactive
and non-interactive rendering purposes, if available.

If Licensee has purchased the Software on the discount terms offered by The Foundry’s Educational Policy published
on its website (“the Educational Policy”), Licensee warrants and represents to The Foundry as a condition of this
Agreement that: (a) (if Licensee is an individual) he or she is a part-time or full-time student at the time of purchase
and will not use the Software for commercial, professional or for-profit purposes; (b) (if the Licensee is not an
individual) it is an organisation that will use it only for the purpose of training and instruction, and for no other
purpose (c) Licensee will at all times comply with the Educational Policy (as such policy may be amended from time to
time).

Finally, if the Software is a "Personal Learning Edition," ("PLE") Licensee may use it only for the purpose of personal or
internal training and instruction, and for no other purpose. PLE versions of the Software may not be used for
commercial, professional or for-profit purposes including, for the avoidance of doubt, the purpose of providing
training or instruction to third parties.

SECTION 3. SOURCE CODE.

Notwithstanding that Section 1 defines “Software” as an object code version and that Section 2 provides
that Licensee may use the Software in object code form only, The Foundry may also agree to license to
Licensee (including by way of upgrades, updates or enhancements) source code or elements of the source
code of the Software the intellectual property rights in which belong either to The Foundry or to a Third
Party Licensor ("Source Code”). If The Foundry does so Licensee shall be licensed to use the Source Code as
Software on the terms of this Agreement and: (a) notwithstanding Section 2 (c) Licensee may use the
Source Code at its own risk in any reasonable way for the limited purpose of enhancing its use of the
Software solely for its own internal business purposes and in all respects in accordance with this
Agreement; (b) Licensee shall in respect of the Source Code comply strictly with all other restrictions
applying to its use of the Software under this Agreement as well as any other restriction or instruction
that is communicated to it by The Foundry at any time during this Agreement (whether imposed or
requested by The Foundry or by any Third Party Licensor); (c) notwithstanding any other term of this
Agreement The Foundry gives no warranty whatsoever in respect of the Source Code, which is licensed on
an “as is” basis, or in respect of any modification of the Source Code made by Licensee ("Modification”); (d)
notwithstanding any other term of this Agreement The Foundry shall have no obligation to provide
support, maintenance, upgrades or updates of or in respect of the Source Code or of any Modification; and
(e) Licensee shall indemnify The Foundry against all liabilities and expenses (including reasonable legal
costs) incurred by The Foundry in relation to any claim asserting that any Modification infringes the
intellectual property rights of any third party.

SECTION 4. BACK-UP COPY.

Notwithstanding Section 2, Licensee may store one copy of the Software and Documentation off-line and
off-site in a secured location owned or leased by Licensee in order to provide a back-up in the event of
destruction by fire, flood, acts of war, acts of nature, vandalism or other incident. In no event may
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Licensee use the back-up copy of the Software or Documentation to circumvent the usage or other
limitations set forth in this Agreement.

SECTION 5. OWNERSHIP.

Licensee acknowledges that the Software (including, for the avoidance of doubt, any Source Code that is
licensed to Licensee) and Documentation and all intellectual property rights and other proprietary rights
relating thereto are and shall remain the sole property of The Foundry and the Third Party Licensors.
Licensee shall not remove, or allow the removal of, any copyright or other proprietary rights notice
included in and on the Software or Documentation or take any other action that could adversely affect the
property rights of The Foundry or any Third Party Licensor. To the extent that Licensee is authorized to
make copies of the Software or Documentation under this Agreement, Licensee shall reproduce in and on
all such copies any copyright and/or other proprietary rights notices provided in and on the materials
supplied by The Foundry hereunder. Nothing in this Agreement shall be deemed to give Licensee any rights
in the trademarks, service marks, patents, trade secrets, confidential information, copyrights or other
intellectual property rights of The Foundry or any Third Party Licensor, and Licensee shall be strictly
prohibited from using the name, trademarks or service marks of The Foundry or any Third Party Licensor in
Licensee's promotion or publicity without The Foundry's express written approval.

SECTION 6. LICENSE FEE.

Licensee understands that the benefits granted to Licensee hereunder are contingent upon Licensee's
payment in full of the license fee payable in connection herewith (the "License Fee").

SECTION 7. UPGRADES/ENHANCEMENTS.

The Licensee's access to support, upgrades and updates is subject to the terms and conditions of the
“Annual Upgrade and Support Programme” available on The Foundry's website. The Foundry may from time
to time and at its sole discretion vary the terms and conditions of the Annual Upgrade and Support
Programme.

SECTION 8. TAXES AND DUTIES.

Licensee agrees to pay, and indemnify The Foundry from claims for, any local, state or national tax
(exclusive of taxes based on net income), duty, tariff or other impost related to or arising from the
transaction contemplated by this Agreement.

SECTION 9. LIMITED WARRANTY.

The Foundry warrants that, for a period of ninety (90) days after delivery of the Software: (a) the machine
readable electronic files constituting the Software and Documentation shall be free from errors that may
arise from the electronic file transfer from The Foundry and/or its authorized reseller to Licensee; and (b)
to the best of The Foundry's knowledge, Licensee’s use of the Software in accordance with the
Documentation will not, in and of itself, infringe any third party's copyright, patent or other intellectual
property rights. Except as warranted, the Software and Documentation is being provided "as is.” THE
FOREGOING LIMITED WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR
IMPLIED, AND The Foundry DISCLAIMS ANY AND ALL IMPLIED WARRANTIES OR CONDITIONS, INCLUDING,
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WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE, REGARDLESS OF WHETHER The Foundry KNOWS OR HAS REASON
TO KNOW OF LICENSEE'S PARTICULAR NEEDS. The Foundry does not warrant that the Software or
Documentation will meet Licensee's requirements or that Licensee's use of the Software will be
uninterrupted or error free. No employee or agent of The Foundry is authorized to modify this limited
warranty, nor to make additional warranties. No action for any breach of the above limited warranty may
be commenced more than one (1) year after Licensee's initial receipt of the Software. To the extent any
implied warranties may not be disclaimed under applicable law, then ANY IMPLIED WARRANTIES ARE
LIMITED IN DURATION TO NINETY (90) DAYS AFTER DELIVERY OF THE SOFTWARE TO LICENSEE.

SECTION 10. LIMITED REMEDY.

The exclusive remedy available to the Licensee in the event of a breach of the foregoing limited warranty,
TO THE EXCLUSION OF ALL OTHER REMEDIES, is for Licensee to destroy all copies of the Software, send
The Foundry a written certification of such destruction and, upon The Foundry's receipt of such
certification, The Foundry will make a replacement copy of the Software available to Licensee.

SECTION 11. INDEMNIFICATION.

Licensee agrees to indemnify, hold harmless and defend The Foundry, the Third Party Licensors and The
Foundry's and each Third Party Licensor’s respective affiliates, officers, directors, shareholders,
employees, authorized resellers, agents and other representatives (collectively, the "Released Parties")
from all claims, defense costs (including, but not limited to, attorneys' fees), judgments, settlements and
other expenses arising from or connected with the operation of Licensee's business or Licensee's
possession or use of the Software or Documentation.

SECTION 12. LIMITED LIABILITY.

In no event shall the Released Parties’ cumulative liability to Licensee or any other party for any loss or
damages resulting from any claims, demands or actions arising out of or relating to this Agreement (or the
Software or Documentation contemplated herein) exceed the License Fee paid to The Foundry or its
authorized reseller for use of the Software. Furthermore, IN NO EVENT SHALL THE RELEASED PARTIES BE
LIABLE TO LICENSEE UNDER ANY THEORY FOR ANY INDIRECT, SPECIAL, INCIDENTAL, PUNITIVE,
EXEMPLARY OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS OR LOSS OF
PROFITS) OR THE COST OF PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, REGARDLESS OF
WHETHER THE RELEASED PARTIES KNOW OR HAVE REASON TO KNOW OF THE POSSIBILITY OF SUCH
DAMAGES AND REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL
PURPOSE. No action arising out of or related to this Agreement, regardless of form, may be brought by
Licensee more than one (1) year after Licensee's initial receipt of the Software; provided, however, to the
extent such one (1) year limit may not be valid under applicable law, then such period shall be limited to
the shortest period allowed by law.

SECTION 13. TERM; TERMINATION.

This Agreement is effective upon Licensee's acceptance of the terms hereof and Licensee's payment of the
License Fee, and the Agreement will remain in effect until termination. If Licensee breaches this Agreement,
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The Foundry may terminate the License granted hereunder by notice to Licensee. In the event the License
is terminated, Licensee will either return to The Foundry all copies of the Software and Documentation in
Licensee's possession or, if The Foundry directs in writing, destroy all such copies. In the later case, if
requested by The Foundry, Licensee shall provide The Foundry with a certificate signed by an officer of
Licensee confirming that the foregoing destruction has been completed.

SECTION 14. CONFIDENTIALITY.

Licensee agrees that the Software (including, for the avoidance of doubt, any Source Code that is licensed
to Licensee) and Documentation are proprietary and confidential information of The Foundry or, as the
case may be, the Third Party Licensors, and that all such information and any communications relating
thereto (collectively, "Confidential Information”) are confidential and a fundamental and important trade
secret of The Foundry or the Third Party Licensors. Licensee shall disclose Confidential Information only to
Licensee's employees who are working on an Authorized Project and have a "need-to-know" of such
Confidential Information, and shall advise any recipients of Confidential Information that it is to be used
only as authorized in this Agreement. Licensee shall not disclose Confidential Information or otherwise
make any Confidential Information available to any other of the Licensee's employees or to any third
parties without the express written consent of The Foundry. Licensee agrees to segregate, to the extent it
can be reasonably done, the Confidential Information from the confidential information and materials of
others in order to prevent commingling. Licensee shall take reasonable security measures, which such
measures shall be at least as great as the measures Licensee uses to keep Licensee's own confidential
information secure (but in any case using no less than a reasonable degree of care), to hold the Software,
Documentation and any other Confidential Information in strict confidence and safe custody. The Foundry
may request, in which case Licensee agrees to comply with, certain reasonable security measures as part
of the use of the Software and Documentation. Licensee acknowledges that monetary damages may not be
a sufficient remedy for unauthorized disclosure of Confidential Information, and that The Foundry shall be
entitled, without waiving any other rights or remedies, to such injunctive or equitable relief as may be
deemed proper by a court of competent jurisdiction.

SECTION 15. INSPECTION.

Licensee shall advise The Foundry on demand of all locations where the Software or Documentation is used
or stored. Licensee shall permit The Foundry or its authorized agents to inspect all such locations during
normal business hours and on reasonable advance notice.

SECTION 16. NONSOLICITATION.

Licensee agrees not to solicit for employment or retention any of The Foundry's current or future
employees who were or are involved in the development and/or creation of the Software.

SECTION 17. U.S. GOVERNMENT LICENSE RIGHTS.

The Software, Documentation and/or data delivered hereunder are subject to the terms of this Agreement
and in no event shall the U.S. Government acquire greater than RESTRICTED/LIMITED RIGHTS. At a
minimum, use, duplication or disclosure by the U.S. Government is subject to the applicable restrictions of:
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(i) FAR §52.227-14 ALTS I, Il and 11l June 1987); (ii) FAR §52.227-19 (June 1987); (iii) FAR §12.211 and
12.212; and/or (iv) DFARS §227.7202-1(a) and DFARS §227.7202-3.
The Software is the subject of the following notices:

e Copyright © 2012 The Foundry Visionmongers, Ltd.. All Rights Reserved.
* Unpublished-rights reserved under the Copyright Laws of the United Kingdom.

SECTION 18. SURVIVAL.

Sections 2, 3,5,6,8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19 and 20 shall survive any termination or
expiration of this Agreement.

SECTION 19. IMPORT/EXPORT CONTROLS.

To the extent that any Software made available hereunder is subject to restrictions upon export and/or
reexport from the United States, Licensee agrees to comply with, and not act or fail to act in any way that
would violate, the applicable international, national, state, regional and local laws and regulations,
including, without limitation, the United States Foreign Corrupt Practices Act, the Export Administration
Act and the Export Administration Regulations, as amended or otherwise modified from time to time, and
neither The Foundry nor Licensee shall be required under this Agreement to act or fail to act in any way
which it believes in good faith will violate any such laws or regulations.

SECTION 20. MISCELLANEOUS.

This Agreement is the exclusive agreement between the parties concerning the subject matter hereof and
supersedes any and all prior oral or written agreements, negotiations, or other dealings between the
parties concerning such subject. This Agreement may be modified only by a written instrument signed by
both parties. If any action is brought by either party to this Agreement against the other party regarding
the subject matter hereof, the prevailing party shall be entitled to recover, in addition to any other relief
granted, reasonable attorneys' fees and expenses of litigation. Should any term of this Agreement be
declared void or unenforceable by any court of competent jurisdiction, such declaration shall have no
effect on the remaining terms of this Agreement. The failure of either party to enforce any rights granted
hereunder or to take action against the other party in the event of any breach hereunder shall not be
deemed a waiver by that party as to subsequent enforcement of rights or subsequent actions in the event
of future breaches. This Agreement shall be governed by, and construed in accordance with English Law.

The Foundry and Licensee intend that each Third Party Licensor may enforce against Licensee under the Contracts
(Rights of Third Parties) Act 1999 ("the Act") any obligation owed by Licensee to The Foundry under this Agreement
that is capable of application to any proprietary or other right of that Third Party Licensor in or in relation to the
Software. The Foundry and Licensee reserve the right under section 2(3)(a) of the Act to rescind, terminate or vary
this Agreement without the consent of any Third Party Licensor.

Copyright © 2012 The Foundry Visionmongers Ltd. All Rights Reserved. Do not duplicate.
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